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Welcome

PI Integrator for Esri® ArcGIS® is a versatile platform that enables real-time geographic data
visualization by connecting your PI System with the Esri ArcGIS Platform. PI Integrator for Esri
ArcGIS combines the "time" aspect of the PI System with the "space" aspect of the Esri ArcGIS
platform to enhance insight over infrastructure processes and increase operational awareness.
PI Integrator for Esri ArcGIS works in conjunction with both Esri ArcGIS server and Esri ArcGIS
Online.
A long-time leader in geographic information systems, Esri powers the creation of data-intense
maps and location-based analytics. Esri's ArcGIS suite of products includes client software for
most common desktop and mobile devices.
OSIsoft is the maker of the PI System, the industry standard for real-time data collection and
time-based analytics. PI supplies data from control systems to operators who monitor the
current status of their assets, and reference a rich, dense history and analytics to explore and
improve their operations.
PI Integrator for Esri ArcGIS is the bridge between the vast raw data and asset information of
the PI System and Esri's powerful mapping capabilities. PI Integrator for Esri ArcGIS functions
as a data provider to the Esri ArcGIS platform, where you can add dynamic features to
functional and geographic maps, and continuously update these features as states, values, and
locations change.
PI Integrator for Esri ArcGIS exposes the full power of the PI System in serving assets for
mapping as features, along with related raw data, aggregates, statistics, and analytics. Related
PI client products allow users to dig deeper into historical data from a map feature to examine
trends leading to an asset's current status.
Esri's ArcGIS GeoEvent Extension for Server (called GeoEvent Processor in this document)
adds additional spatial aggregation and mapping capabilities that allow users to monitor assets
individually or grouped geographically. Together, Esri and OSIsoft's integrated services
provide new ways to monitor assets including heat maps, or alerts and events triggered by
movement.
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Architecture 
PI Integrator for Esri ArcGIS supplies real-time PI System data together with geo-spatial
context information to the ArcGIS platform. ArcGIS Online and ArcGIS Server enable you to
overlay many different kinds of information on a map.
GeoEvent Processor is an add-on to the ArcGIS server, and enables real-time geospatial
analysis. PI Integrator for Esri ArcGIS serves real-time data streams to GeoEvent processor.

Deployment architecture, cloud-based configuration

Welcome
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Deployment architecture, on-premises configuration

Glossary
• PI Integrator for Esri ArcGIS

A new OSIsoft product suite to integrate with Esri's ArcGIS platform, and consisting of
multiple applications to support the integration, including different UI components or client
applications.

• Feature

An item (with a geometry) that represents an asset, a measurement or a series of
measurements. A feature can have attributes that represent values or measurements
associated with the feature.

• Geometry

A geographical location and shape. The simplest geometry would be a point on a map (x,y).
Geometries can be a point, multipoint, polyline polygon, or an extent -- for example, a well, a
series of measurements, or a road.

• Feature Service

Esri technology. A REST (REpresentational State Transfer) service that exposes information
that can be projected onto a map according to Esri specifications. Typically this information
consists of (physical) assets or measurements that contain location information.

• Streaming Service

Esri technology. A web socket based service that can push data updates to a consumer. For
instance a web page that can receive value updates for a specific Feature, without having to
periodically poll the Feature Service for updates.

Welcome
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• Geographical Coordinate Systems (GCS )

Geographical Coordinate Systems enable every location on the Earth to be specified by a set
of numbers or letters.
About geographic coordinate systems (http://webhelp.esri.com/arcgisdesktop/9.2/
index.cfm?TopicName=About_geographic_coordinate_systems)

• Projected Coordinate System (PCS)

A projected coordinate system is always based on a sphere or spheroid geographic
coordinate system, but defined on a flat, two-dimensional surface. Unlike a geographic
coordinate system, a projected coordinate system has constant lengths, angles, and areas
across the two dimensions.
About projected coordinate systems (http://webhelp.esri.com/arcgisdesktop/9.2/
index.cfm?TopicName=About_projected_coordinate_systems)

Product prerequisites
PI Integrator for Esri ArcGIS requires specific versions of some product components and
supporting software.
PI System components

Certain capabilities of PI Integrator for Esri ArcGIS rely on the latest versions of several OSIsoft
modules. While not necessarily required, it is strongly recommended that customers be on the
following production releases:
• PI Server 2012

◦ PI Data Archive version 3.4.390 or later
◦ PI AF Server version 2.5 or later (v 2.6 recommended)

• PI Coresight 2013
• PI Integrator for Esri ArcGIS - Portal (on-premises only)

◦ Microsoft Windows Server 2012®

◦ Internet Information Services (IIS)® 8.0
◦ Access to a local or remote Microsoft SQL Server 2008 R2® or later

• PI Integrator for Esri ArcGIS - Data Relay service (included in the Data Relay setup kit are
Microsoft .Net Framework 4.5.1 and PI AF SDK version 2.6.1)
◦ Microsoft Windows Server 2008® R2

Esri ArcGIS Platform components

All Esri components must be version 10.2.1 or later:
• ArcGIS Server
• ArcGIS Desktop
• Esri ArcGIS GeoEvent Extension for Server (called GeoEvent Processor in this document)
• Portal for ArcGIS Server or ArcGIS Online Subscription

Welcome
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• Operations Dashboard for ArcGIS
• Must have administrator credentials for ArcGIS GeoEvent Processor
• ArcGIS accounts used to create Data Stores in the GeoEvent Processor Manager must be

sufficiently privileged to create a hosted Feature Service
Other

For a browser, use Internet Explorer version 11 or later, or the latest version of Firefox or
Chrome.

Features and capabilities
Esri's ArcGIS suite helps you to visualize the data that underpins your PI assets. ArcGIS
displays this information many different ways, such as colored features on the map, event
records created as a Geo Fence is violated, and even hyperlinks into the PI Coresight
application for further historical analysis.
Features include:
• Uniform asset-based operation

PI Integrator for Esri ArcGIS is a ready-to-consume framework. During installation, your
administrator configures the PI System and ArcGIS to use corresponding PI assets as rich
features, as they are known in ArcGIS. These assets may correspond to physical assets you
want to place on a map (electrical meters, vehicles, slurry ponds) or may be functional in
nature (aggregates of physical assets, by area, connectivity, or type).
The data available to you is gathered and arranged for intuitive use. Similar assets are easy
to compare - for example, the efficiency of every electric pump, or the load-factor of every
power consumer. What appears in one system is ready for further analysis in the other.
As business needs evolve, you and your colleagues might participate in enriching the
current assets (to contain more information) or in bringing additional assets online (more
assets to power your maps).

• Real-time data

ArcGIS map symbols can update dynamically - through color, shape or size - to reflect real-
time status or data values. For example, an operator may ask: show me each power
transformer's core temperature, by colored quartile, or size them by time since their last
maintenance.

• Historical data

Click a map feature to expose a pop-up window containing details of operation and
historical trends of asset values. A hyperlink takes you directly to a detail view in PI
Coresight with rich visualization features and hands-on, interactive analysis.

• Time-based analytics

Time-based statistics are readily available for you to see as details or to show directly on
the map. With its support of time, PI Data Archive provides ready-to-use statistics such as
average, standard deviation, and maximum or minimum event frame.

Welcome
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• Geographical analysis

Esri GeoEvent Processor can continuously analyze the location of moving assets and
determine if they have violated a virtual border. You can add such borders, or Geo Fences,
to a map region in order to monitor activity.

• Layering and zooming

Configure map views and the visibility of corresponding feature layers to see the level of
aggregation desired. Typically, granular feature-level data is shown.

• Advanced cartography

PI Integrator for Esri ArcGIS can provide data to Esri GeoEvent Processor in native formats,
allowing features such as visual heat maps based on magnitudes of values and geographical
proximities. These advanced cartography applications allow you to pose and answer more
complex geographic questions visually:
◦ Where do my wind turbines underperform in the early morning hours?
◦ What terrain patterns seem to correlate with this?

Welcome
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Installation and configuration roadmap
Two versions of PI Integrator for Esri ArcGIS are available:
• A cloud-based version, in which PI Integrator for Esri ArcGIS portal is accessed securely

from the internet.
• An on-premises version, in which PI Integrator for Esri ArcGIS portal is run on a local

computer within your organization.
See Architecture for information about how the cloud-based and on-premises versions of PI
Integrator for Esri ArcGIS are configured.
Roadmap:

1. Ensure you have met the prerequisites for running PI Integrator for Esri ArcGIS. See
Product prerequisites.

2. Determine which license was purchased for your organization: cloud-based or on-premises:
◦ For on-premises PI Integrator for Esri ArcGIS follow the software installation steps here:

Install the portal software. Like all OSIsoft products, you can download the software
from https://techsupport.osisoft.com (https://techsupport.osisoft.com) or from
vCampus.

◦ For cloud-based PI Integrator for Esri ArcGIS, obtain the link and necessary credentials
from your OSIsoft representative.

3. Follow the Administrator configuration steps: Administrator configuration.
4. Follow the User configuration steps: User configuration.
5. If necessary, perform any additional configuration tasks: Additional configuration tasks.
6. Create your map and configure it with your PI data: Map and layer configuration.
For help adding Esri assets to your PI system, see: Utilities.
For help with diagnosing technical issues, see: Troubleshooting
For additional help that is beyond the scope of this user manual, see: Technical support and
other resources.
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Prepare to install the portal software (on-premises
version only)

When installing the on-premises Configuration Portal software, proper configuration of IIS and
SQL Server is required.
The following software must be installed before installing the PI Integrator for Esri ArcGIS
portal software:
• Microsoft Windows Server 2012
• Microsoft .Net Framework 3.5 and .Net Framework 4.5.1. (Microsoft .Net Framework is

available for download from Microsoft.)
• Internet Information Services (IIS) 8.0

The following Server Roles and Role Services are prerequisites:
◦ Server Roles

▪ Application Server
▪ Web Server (IIS)

◦ Application Server Role Services
▪ .NET Framework 4.5
▪ Web Server (IIS Support)

◦ Web Server Role Services
▪ Security

◦ Basic Authentication
◦ Windows Authentication

▪ Application Development
◦ .NET Extensibility 4.5
◦ Application Initialization
◦ ASP.NET 4.5
◦ WebSocket Protocol

◦ Management Tools
▪ IIS Management Console

After IIS is installed with all of the necessary Role Services, the following configurations are
required within the Web site where the Configuration Portal will be installed. A Web
application (within the chosen Web Site) and a dedicated Application Pool will be created
automatically during installation. As long as configuration prerequisites are satisfied, it is
permissible to share the Web Site with other Web Applications. Use of the "Default Web
Site" is acceptable. See Configure IIS for more information.
Web Site configuration
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◦ Site bindings (may use non-default ports if necessary)
▪ HTTP
▪ HTTPS (with trusted certificate) See Configure SSL for SSL configuration steps.

◦ Authentication
▪ Anonymous Authentication: Enabled
▪ Windows Authentication: Enabled
▪ All other authentication methods: Disabled

• Microsoft SQL Server (Installed locally or on the network.)
If you intend to use Windows Authentication for the Configuration Portal's connection:
◦ The Windows user account that will be used to install the Configuration Portal must be

added as an SQL Server Login, and mapped to the following Server roles:
▪ dbcreator
▪ securityadmin

◦ This Login mapping is only required during installation. After installation, the installing
user's SQL login may be removed or de-mapped as desired.

◦ During installation, the installer creates a login for the Configuration Portal to use, with
permissions confined to the Configuration Portal's own database. This login must remain
for the Configuration Portal to function properly.

If you will use legacy SQL Server Authentication for the Configuration Portal's connection:
◦ The same SQL Login designated for use by the Configuration Portal will also be used

during installation.
◦ During installation, this SQL Login must be mapped to the following Server Role:

▪ dbcreator
◦ This Login mapping is only required during installation. After installation, the server-

level dbcreator mapping can be removed.
◦ This Login will become the owner of the Configuration Portal’s newly-created database,

and the Configuration Portal will use this SQL Login to access its database.

Install the portal software 
You can install the portal software using either Windows Integrated Authentication or SQL
Server authentication. Using Windows authentication, the application uses the Windows user
ID and password that were used when you logged into your computer. Using SQL Server
authentication, you must enter the SQL Server user ID and password that were created when
SQL Server was installed.
You must install the Configuration Portal on a dedicated web server that has access to a
Microsoft SQL Server. The Configuration Portal may authenticate with the SQL Server either
via Windows Authentication or legacy SQL Authentication. During installation, you will have
the opportunity to validate the connection and authentication.

Prepare to install the portal software (on-premises version only)
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Before you start

• Ensure that you have met all of the prerequisites listed in: Prepare to install the portal
software (on-premises version only)

• To install the portal software, you must have administrator rights on that computer.
Procedure

1. Download the latest version of configuration portal for PI Integrator for Esri ArcGIS from
either Vcampus or from Tech support (https://techsupport.osisoft.com).

2. Run the downloaded file. 
The file is a self-extracting archive that contains the installation program and support files.

3. In the destination folder field, enter the path for the installation files or accept the default
location and then click OK. 
The installation program starts automatically after the files are extracted. You can also click 
Change to modify the installation path.

4. Click Ok. The Configuration Portal Setup screen displays.
5. In the destination folder field, enter the path for the installation files or accept the default

location and then click OK. 
You can also click Change to modify the installation path.

6. Click Next.
7. Select the IIS Web site into which the Web application will be installed. 

The Web application must be installed in Microsoft Internet Information Services (IIS).
8. Click Next.
9. Enter the name of the SQL Server on which PI Integrator for Esri ArcGIS Portal will store

application data. 
In the Server Instance field, enter the name and location of the SQL Server. Use "." to
indicate localhost. For example, if your SQL Server is named SQLExpress and is located on
the same computer you are running the installation on, you can specify: .\SQLExpress.
The Database Name field indicates the name of the database on the SQL Server. You do not
need to specify anything in this field if this is the first time the installation program is run. If
you are reinstalling, enter the name of the database you intend to use.

10. Choose either Windows Integrated Authentication or SQL Server Authentication.
a. For Windows Integrated Authentication no additional information is needed.
b. For SQL Server Authentication, enter the user ID and password that were used to create

the SQL Server instance. Note that these credentials will be stored in clear text in the
web application's configuration. 

Note:
The use of SQL Server Authentication is not recommended. If SQL Server
Authentication is desired, you should first create a dedicated SQL login with
minimum server privileges as detailed in the prerequisites above. The login should
be created specifically for use by PI Geo administrator. The login should be defined
with dbcreator and securityadmin roles, which may be removed after installation.

Prepare to install the portal software (on-premises version only)
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11. Click Validate to verify that the user ID and password are valid.
12. Click Next. 

You are now ready to begin the software installation.
13. Click Install. 

You can click Back if you want to modify any of the settings that were entered previously.
After completing the installation, you can confirm that the installation was successful by
navigating to:
https://<machine-name>/pigeoportal

After you finish

When the Configuration Portal software is upgraded, the upgrade is detected by all supported
web browsers and the latest version of the Configuration Portal website is reloaded
automatically. No other actions are required of users.

Note:
When logging in to your portal server after the installation is complete, you might
encounter a warning that your machine certificate is not trusted. A known issue with
Mozilla Firefox might prevent you from attempting to trust a machine certificate. See
Mozilla bug (https://bugzilla.mozilla.org/show_bug.cgi?id=659736) for more
information.

Configure IIS

Installing IIS does not install the WebSocket Protocol by default. Rather, it must be manually
configured for Portal installations.
Procedure

1. From the Control Panel, select Programs and Features, then start the Server Manager utility
2. Select Manage > Add Roles and Features. 

The Add Roles and Features Wizard starts.
3. Select Server Roles, scroll through the list of features and select WebSocket Protocol 

You can find WebSocked Protocol in the hierarchy as shown here: Web Server (IIS) > Web
Server > Application Development > WebSocket Protocol.

4. Check the box to enable the WebSocket Protocol and click OK. 

Prepare to install the portal software (on-premises version only)
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Configure SSL

You must configure an SSL binding to allow web access to your portal. By default, sites of type
HTTP are bound to TCP/IP port 80. Follow the steps in this topic to enable secure HTTPS
access to your portal.
If you are not familiar with configuring SSL web sites in IIS, refer to Microsoft documentation
or contact your local IT administrator.
Procedure

1. Start the Internet Information Server (IIS) Manager application.
2. Click portal site name > Sites > Default Web Site

3. From the Actions menu, in the Edit Site sub-menu, select Bindings. 
The Site Bindings screen displays.

4. On the Site Bindings screen, click Add. 
The Add Site Binding screen displays.

5. In the Type list, select https. 
The IP address default setting of "All Unassigned" is filled in automatically, which means
that any IP address that accesses the site will be allowed to communicate with it. The Port
field is filled in automatically with 443. These settings are probably correct for most
installations.

6. In the SSL certificate field, select a certificate from the list. 
SSL validates web sites using certificates. When Windows is installed, a machine certificate
is created automatically. Depending on the particular IT policies at your location, you can

Prepare to install the portal software (on-premises version only)
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specify either the existing machine certificate, or your IT group might issue a certificate
specifically for your internal portal website. If your organization has a custom certificate,
click the Select button and select it from the list. You must specify a certificate to proceed.

7. In the Host name field, specify the complete portal host name. 
You can verify the host name by specifying the SSL certificate and clicking View. On the
Certificate screen, the complete name is shown after the "Issued to" field. The certificate
name is not case sensitive.

8. When finished, click OK.

Prepare to install the portal software (on-premises version only)
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Administrator configuration
While logged on as a PI Integrator for Esri ArcGIS system administrator, you must perform a
few configuration tasks before users can access PI Integrator for Esri ArcGIS. Perform the
setup steps in each of the topics that follow.
Topics in this section

• PI Integrator for Esri ArcGIS Data Relay
• Configure ArcGIS GeoEvent Processor endpoint

The ArcGIS GeoEvent Processor endpoint is a URL that identifies the location of ArcGIS
GeoEvent Processor Manager, which permits remote configuration of ArcGIS GeoEvent
Processor.

• Configure PI Coresight server endpoint
The PI Coresight server endpoint is a URL that identifies the location of your PI Coresight
server.

• Additional configuration tasks
Depending on your particular system requirements, you might need to perform these
additional configuration steps.

PI Integrator for Esri ArcGIS Data Relay
The PI Integrator for Esri ArcGIS Data Relay is a data client that runs on a computer located
within your corporate network. It provides data to the PI Integrator for Esri ArcGIS Portal.
When the Portal is hosted in the cloud, the Data Relay sends your PI data securely across a
service bus to the Portal. When the portal is hosted on-premises, the Data Relay sends data
across your local network to the Portal. Due to the nature of PI data retrieval, the Data Relay
might incur significant computational and memory overhead. The Data Relay should be
installed on a dedicated server whenever possible.

Caution:
Do not install more than one Data Relay instance. Before installing a Data Relay, you
should check whether a Data Relay is already installed by clicking Administration > Data
Relay. The following message is displayed if a Data Relay is already installed:
Your Data Relay is running on node 'node_name'

Tip:
Do not install the Data Relay that you intend to use for your production environment on a
shared server of any kind; rather, you should install the Data Relay on a dedicated server
(in a manner similar to how PI Coresight is installed). The Data Relay is where AF Data
references are executed and the load on the computer will be significant when accessing
a mature AF database. While it is technically possible to run several OSIsoft processes on
a single computer, a production environment should use a separate computer for the
Data Relay.

Data Relay architecture
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Note:
Data is not stored in the cloud. Your Azure Service Bus is private and is not shared with
any other tenant.

Note:
The on-premises Data Relay monitors connections from the on-premises Portal on port
5464. This port must be open on the Data Relay machine.

The recovery behavior of the Data Relay service is set to restart the service if a failure occurs.
While it is possible to modify the behavior of the service by using the Windows service
configuration, it is recommended that the service remains set to Restart the service. If the
service fails and is not set to automatically restart, it will become unavailable until it is

Administrator configuration
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manually restarted. PI Integrator for Esri ArcGIS cannot function properly without a working
Data Relay.

Install and configure the cloud Data Relay

Note:
The steps in this topic are mandatory if you are using the cloud version of PI Integrator
for Esri ArcGIS. If you are using the on-premises version, see Install and configure the on-
premises Data Relay instead.

Before you start

• The client node you intend to use for the Data Relay must have Microsoft .Net Framework
4.5.1 installed.

• You should exit any open Windows programs before running the Data Relay Setup Wizard.
See PI Integrator for Esri ArcGIS Data Relay for more information.
Procedure

1. Log in as Administrator on the computer on which the Data Relay is to be installed. 
You must be an administrator on the Data Relay node when running the installer.

2. Using a browser, access the link to the PI Integrator for Esri ArcGIS configuration portal and
log in as Administrator.

3. Navigate in the Portal to the Administration > Data Relay page and consult the 
Configuration settings section. 
Make a note of or copy the values provided for Issuer Name, Namespace, and Shared Key;
you will need these values in a later step.

4. Start the PI Integrator for Esri ArcGIS Data Relay Wizard by selecting Administration > Data
Relay. 
The PI Integrator for Esri ArcGIS Data Relay Setup window opens.

5. On the Welcome screen, click Next.
6. Enter the folder in which to download and install the Data Relay. 

You can modify the path by clicking the Change button.
7. Click Next.
8. Select either The default service account for this service or A custom account. 

While not recommended, you can select the default account when you want the Data Relay
to run under a local service account created specifically for the Data Relay. This local
account might not work optimally with PI System security. You should instead create a
dedicated service account on your domain, and use the custom account option to run the
Data Relay under this dedicated user account. Regardless of which option you choose, the
service account must have read permissions to all PI Data Archive and Asset Framework
servers that you want to access. This access may be granted using either a legacy PI Trust or
by using Windows Integrated Security. If prompted, provide the custom service name and
password, and click Next.

Administrator configuration
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9. Enter the values for Issuer Name, Namespace, and Shared Key that you obtained from step
3.

10. Click Next.

11. Click Install. 
A message is displayed if the service was successfully started:
Successfully completed the PI Integrator for Esri ArcGIS Data Relay
Setup Wizard

12. Click Finish. 
To uninstall or modify PI Integrator for Esri ArcGIS Data Relay service, start Microsoft
Control Panel, then select Programs and Features. Find and select PI Integrator for Esri
ArcGIS Data Relay and then select either Uninstall or Change.

Install and configure the on-premises Data Relay

Note:
The steps in this topic are mandatory if you are using the on-premises version of PI
Integrator for Esri ArcGIS. If you are using the cloud version, see Install and configure the
cloud Data Relay instead.

Before you start

• The client node you intend to use for the Data Relay must have both Microsoft .Net
Framework 3.5 and Microsoft .NET Framework 4.5.1 installed.

• You should exit any open Windows programs before running the Data Relay Setup Wizard.
See PI Integrator for Esri ArcGIS Data Relay for more information.
Procedure

1. Log in as Administrator on the computer on which the Data Relay is to be installed. 
You must be an administrator on the Data Relay node when running the installer. You can
view users with administrator privileges by selecting the PI Geo Admins local group on the
PI Integrator for Esri ArcGIS Portal server.

2. Log in to PI Integrator for Esri ArcGIS portal by navigating to: https://machine name/
pigeoportal or to: FQDN/pigeoportal, where FQDN is the Fully Qualified Domain Name.

3. Navigate in the Portal to the Administration > Data Relay page and consult the 
Configuration settings section. Make a note of or copy the value of ApplicationPoolID; you
will need this value in a later step. 
For new installations, if a data relay has not been configured previously, the following
message displays:
You do not have a PI Integrator for Esri ArcGIS Data Relay installed, properly 
configured or running. PI integrator for Esri ArcGIS cannot properly operate 
without the Data Relay. See help for more information.

4. Click Download latest to download the installation kit for the Data Relay.
5. Depending on the browser you are using, follow the steps necessary to download and start

the Data Relay installation program. 
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The PI Integrator for Esri ArcGIS Data Relay Welcome window opens.
If prompted, install PI-SDK and AF Client.

6. On the Welcome screen, click Next.
7. Enter the folder in which to download and install the Data Relay. 

You can modify the path by clicking the Change button.
8. Click Next.
9. Select either The default service account for this service or A custom account. 

While not recommended, you can select the default account when you want the Data Relay
to run under a local service account created specifically for the Data Relay. This local
account might not work optimally with PI System security. You should instead create a
dedicated service account on your domain, and use the custom account option to run the
Data Relay under this dedicated user account. Regardless of which option you choose, the
service account must have read permissions to all PI Data Archive and Asset Framework
servers that you want to access. This access may be granted using either a legacy PI Trust or
by using Windows Integrated Security. If prompted, provide the custom service name and
password.

10. Click Validate to verify that the credentials are valid, and then click Next.
11. Fill in the Portal Identity using the value you obtained in Step 3.
12. Click Next.
13. Click Install. 

A message is displayed if the service was successfully started:
Successfully completed the PI Integrator for Esri ArcGIS Data Relay
Setup Wizard

14. Click Finish. 
To verify that the Data is installed and running, log in to the portal as administrator, then
navigate to Administrator > Data Relay and verify that the following message displays:
Your Data Relay is running on node 'node_name' 

To uninstall or modify PI Integrator for Esri ArcGIS Data Relay service, start Microsoft
Control Panel, then select Programs and Features. Find and select PI Integrator for Esri
ArcGIS Data Relay and then select either Uninstall or Change.

Configure ArcGIS GeoEvent Processor endpoint

Before you start

Ensure that you have access to a working ArcGIS GeoEvent Processor and that you know the
URL of the ArcGIS GeoEvent Processor Manager.

Note:
This document uses the term ArcGIS GeoEvent Processor to refer to the Esri ArcGIS
GeoEvent Extension for Server.
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Procedure

1. Using a browser, access the link to the PI Integrator for Esri ArcGIS configuration portal and
log in.

2. Select Administration > Systems. If no ArcGIS GeoEvent Processor servers were defined
previously, the following message displays:
You don't have any GeoEvent Processor servers registered. Click here to
add one.

If one or more ArcGIS GeoEvent Processor servers have been defined, they are listed
alphabetically on the page.

3. Click the Add GeoEvent Processor button. The Add known PI ArcGIS GeoEvent Processor
endpoint window opens.

4. Enter a name for the ArcGIS GeoEvent Processor server in the Name field. 
You can use any name; however, you should select a name that is easy to remember.

5. Enter a description for the ArcGIS GeoEvent Processor server in the Description field.
6. Enter the endpoint or URL of the ArcGIS GeoEvent Processor server in the Endpoint field. 

The URL should have the following format:
https://server:port

For example:
https://my.geoeventserver.int:6143

It is not necessary to specify the full path to GeoEvent Processor Manager.
7. Click Add.

Configure PI Coresight server endpoint

Procedure

1. If necessary, access the link to PI Integrator for Esri ArcGIS configuration portal and log in.
2. Select Administration > Systems. 

If no PI Coresight servers were defined previously, the following message displays:
You don't have any PI Coresight servers registered. Click here to add
one.

If one or more PI Coresight servers have been defined, they are listed alphabetically on the
page.

3. Click Add PI Coresight server. 
The Add known PI Coresight service window opens.

4. Enter a name for the Coresight server in the Name field. 
You can use any name; however, you should select a name that is easy to remember.

5. Enter a description for the Coresight server in the Description field.
6. Enter the Endpoint or URL of the Coresight server in the Endpoint field. 
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The URL should have the following format:
https://server:port/folder

For example:
https://my.computer.int:80/coresight

7. Click Add.

Additional configuration tasks
Your ArcGIS Online account is registered as a Data Store in ArcGIS GeoEvent Processor. The
same credentials for that Data Store are used when creating a Feature Service through the
configuration portal. In addition, the ArcGIS Online user must be an administrator in ArcGIS
Online. For more information about configuring Data Stores in GeoEvent Processor, see
Managing data stores (http://pro.arcgis.com/en/share/geoevent-processor/administer/
managing-data-stores.htm).
If applicable for your site, follow the steps in the remaining topics in this section.

Configure a proxy server (for cloud installations)

If you are running the cloud version of PI Integrator for Esri ArcGIS and your organization
routes network traffic through a proxy server, you should follow the steps in this section to
configure the Data Relay.
The Data Relay opens a bidirectional communication channel over the internet, which might
require a proxy at some sites. The data relay uses standard HTTPS ports (443) to
communicate, which might require routing through a web proxy depending on your
organization's IT policy.
The on-premises version of PI Integrator for Esri ArcGIS Data Relay acts as a local server that
accepts requests from the Configuration Portal and does not usually require communication
through a proxy server.
Normally, the cloud version of the Data Relay communicates with the Azure Service Bus using
port 443, which is the standard port for HTTPS (Web) traffic. If your organization routes
HTTP(S) traffic through a proxy, you must edit the Data Relay configuration file to make the
Data Relay aware of the proxy. After following the steps below, all network traffic going to and
from the Azure Service Bus is routed through the specified proxy server.
Procedure

1. Navigate to the directory that contains the Data Relay program files, then open the file: 
OSIsoft.DataRelay.Connector.exe.config. Normally the location is: 
%ProgramFiles%\OSIsoft\Integrators\Esri ArcGIS Data Relay\
 OSIsoft.DataRelay.Connector.exe.config

2. Edit the file and add the following lines: 
 <system.net>
    <defaultProxy enabled="true" useDefaultCredentials="true" />
  </system.net>

3. Stop and restart the Data Relay service. 
If successful, the following message is displayed:
Your Data Relay is running (on node 'node_name')
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Configure a proxy server (for on-premises installations)

If you are running the on-premises version of PI Integrator for Esri ArcGIS and your
organization routes network traffic through a proxy server, you should follow the steps in this
section to allow network access between the on-premises PI Integrator for Esri ArcGIS and
Windows Azure. You must follow these steps to obtain access to PI Integrator for Esri ArcGIS
Data Relay and to download the latest version. These steps also enable the ability to send
usage information to OSIsoft (if you have previously agreed to sending usage information).
Procedure

1. Navigate to the directory that contains the file: web.config. Normally the location of the
file is: 
%ProgramFiles%\OSIsoft\Integrators\PI Integrator for Esri ArcGIS\

2. Edit the file and add the following lines: 
 <system.net>
    <defaultProxy enabled="true" useDefaultCredentials="true" />
  </system.net>

3. Stop and restart the Data Relay service. 
If successful, the following message is displayed:
Your Data Relay is running (on node 'node_name')

Results

You can find more information about the defaultProxy Element network setting at Microsoft's
Developer Network here: Proxy settings (http://msdn.microsoft.com/en-us/library/
kd3cf2ex(v=vs.110).aspx)

Configure a secure WebSocket

GeoEvent Processor versions earlier than 10.3 do not support a secure WebSocket. Secure
WebSockets are to WebSockets what https is to http. A secure WebSocket permits users to
create an encrypted connection that prevents data from being intercepted or interpreted.
Configuring secure WebSockets ensures that the data you send back and forth to the cloud is
encrypted and secure.
While logged in as GeoEvent Processor administrator, you must install the secure WebSocket
transport into GeoEvent Processor. You do this by editing the Java runtime environment
properties file, then adding the WebSocket transport.
Use the information in the sections that follow to install a WebSocket adaptor for GeoEvent
processor.
Installing the secure WebSocket is a temporary workaround. A later version of GeoEvent
Processor will support secure WebSocket input.

Modify the JRE properties file

The Java Runtime Environment (JRE) properties file is the configuration file for the Java
Runtime Engine. The file is read when the application starts and pre-loads any external

Administrator configuration

22  PI Integrator for Esri® ArcGIS® 1.0 User Guide Beta 3

http://msdn.microsoft.com/en-us/library/kd3cf2ex(v=vs.110).aspx


libraries or Java Framework libraries that the Geo Event Processor requires to run. Two
libraries are missing from the properties file and must be added. The files are framework
libraries.
Procedure

1. On the GeoEvent Processor server, open the jre.properties file as administrator. 
The jre.properties file is normally located in the following directory:
c:\Program Files\ArcGIS\Server\GeoEventProcessor\etc

The file contains a list of the Java runtime libraries that GeoEvent Processor loads when it is
run.

2. Scroll to the JRE-1.7 section of the file. 
The file should resemble the following:
# Standard package set.  Note that:
#   - javax.transaction* is exported with a mandatory attribute
jre-1.7= \
javax.accessibility, \
# javax.activation, \
javax.activity, \
# javax.annotation;version="1.1", \
javax.annotation.processing;version="1.1", \

3. Add sun.misc and sun.reflect as shown in the following example. 
# Standard package set.  Note that:
#   - javax.transaction* is exported with a mandatory attribute
jre-1.7= \
sun.misc, \
sun.reflect, \
javax.accessibility, \
# javax.activation, \
javax.activity, \
# javax.annotation;version="1.1", \
javax.annotation.processing;version="1.1", \

4. Use the Services applet in Control Panel to stop and then restart the GeoEvent Processor
service.

Install the secure WebSocket transport

Before you start

Ensure that you have downloaded the file: Secure Websocket Transport for GeoEvent
Processor.zip. The compressed file contains the two jar files:
wss-transport-10.2.jar

feature-json-adapter-10.2.1.jar

The file is available from the OSIsoft Tech Support site: Tech Support (https://
techsupport.osisoft.com/).
Procedure

1. Extract the two files that are contained in Secure Websocket Transport for
GeoEvent Processor.zip to a known location.

2. Log in to ArcGIS GeoEvent Processor Manager.
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3. Navigate to the following site: 
https://your_server_name:6143/geoevent/manager/components.html

4. Click the Site button, then select Components. 
A list of transports to GeoEvent Processor is displayed. Normally, the WebSocket Inbound
layer is used for unsecured transport. You will add an additional layer that will support
secure WebSockets (WSS).

5. Click the Add Local Transport button. 
The Add Local Transport window opens.

6. In the Add Local Transport window, click Choose File, then browse to the wss-
transport-10.2.jar file.

7. Click Add. 
You might have to refresh your browser to see the WSS inbound transport:
WssInboundTransport inbound 10.2.1 This is a Secure WebSocket Inbound
transport

8. On the menu, click Adapters.
9. Click Add Local Adapter. 

The Add Local Adaptor window opens.
10. In the Add Local Adaptor window, click Choose File, then browse to the feature-json-

adapter-10.2.1.jar file.
11. Click Add. 

You might have to refresh your browser.
The GeoEvent Processor is now capable of communicating through a secure WebSocket.
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User configuration
After the administrator has configured your system, you perform the steps in the following
sections to configure PI Integrator for Esri ArcGIS for your specific requirements.
In the sections that follow, you will create and configure services and layers. A layer defines a
set of search parameters that are used to select elements in the AF database. These AF
elements will be represented as map features. A service can contain one or more layers. A
service is a logical grouping of Layers. Layers represent REST service endpoints.
Topics in this section

• Configure certificates
Follow the steps in this section to first export certificates from PI Integrator for Esri ArcGIS
Configuration Portal and Esri GeoEvent Processor, and then import the certificates to your
local computer.

• Create a service
You create a service to expose information that can be projected onto a map according to
Esri specifications.

• Create a layer
A layer defines a set of search parameters that are used to select elements in the AF
database. These AF elements will be represented as map features. A service can contain one
or more layers.

• Run the ArcGIS Platform Wizard
You run the ArcGIS Platform Wizard to connect the layer to the ArcGIS platform.

Configure certificates
To avoid security problems with your browser, you must convert and import a security
certificate into the GeoEvent Processor's keystore file.
Follow the steps in this section to first export certificates from PI Integrator for Esri ArcGIS
Configuration Portal and Esri GeoEvent Processor, and then import the certificates to your
local computer.

Import certificates

You use the Microsoft Management Console (MMC) to first export one certificate from PI
Integrator for Esri ArcGIS Configuration Portal computer and one from GeoEvent Processor
computer. You then import the certificates to your local computer. The steps below describe
how to import the certificates and save them to files.
Before you start

You must be an administrator on the local computer and on the target computer.
In addition to your local computer, you must have access to the following:
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• The computer that is running PI Integrator for Esri ArcGIS Configuration Portal.
• The computer that is running GeoEvent Processor.

Procedure

1. On your Windows desktop, select Start > Run, then enter mmc.exe. 
An empty MMC screen opens.

2. Select File > Add/Remove snapin. The Add or Remove Snap-ins screen displays.
3. Find and double-click the Certificates snap-in. 

The Certificates snap-in screen displays.
4. Select the Computer account radio button then click Next. 

The Select Computer screen displays.
5. Select the Another computer radio button.
6. If you know the name of the Configuration Portal then enter its name in the text box;

otherwise, click Browse and locate and select the Configuration Portal computer. If this is
your second time through these steps, specify the GeoEvent Processor computer.

7. Click Finish then click OK. A certificates tree is compiled within MMC for the computer you
are using.

8. Expand the certificates tree to the level of Remote Desktop; generally a single entry will be
shown for the intended target computer.

9. Right click on Remote Desktop then select All tasks > Export. 
The Certificate Export Wizard displays.

10. Click Next, Next, Next to reach the fourth panel, leaving the settings in the first three panels
with default settings. On the fourth panel enter a filename that you will remember when it
comes time to import the file, then click OK.

11. Repeat steps 1 - 10 for the GeoEvent Processor computer.

Export certificates

You use the Microsoft Management Console (MMC) to first export one certificate from PI
Integrator for Esri ArcGIS Configuration Portal computer and one from GeoEvent Processor
computer. You then import the certificates to your local computer. The steps below describe
how to import the certificates to your local computer.
Before you start

You must be an administrator on the local computer and on the target computer.
Procedure

1. On your Windows desktop, select Start > Run, then enter mmc.exe. 
An empty MMC screen opens.

2. Select File > Add/Remove snap-in. The Add or Remove Snap-ins screen displays.
3. Find and double-click the Certificates snap-in. 
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The Certificates snap-in screen displays.
4. If necessary, select the Local computer radio button then click Finish then click OK. 

A Certificates tree is compiled into MMC for importing to the Local Computer.
5. Expand the certificates tree to the level of Trusted Root Certificate Authorities.
6. Right click on Trusted Root Certificate Authorities then select All tasks > Import. 

The Certificate Import Wizard displays.
7. Browse to or enter the filename you used during the export steps, select the file, then click 

Next.
8. Ensure that the radio button next to Trusted Root Certificate Authorities is selected and

click Next.
9. Click Finish then click OK. 

Verify that your new certificate is present in the list. Repeat from step 1 for each of the
previously imported certificates.
Close the MMC utility when finished.

Create a service
You create a service to expose information that can be projected onto a map according to Esri
specifications. Typically this information consists of feature (asset) attributes or
measurements that have location information.
When configuring a service, you can select whether the service supports a StreamServer and a
DisplayServer. The StreamServer allows you to stream data from your PI System to the ArcGIS
platform. The DisplayServer provides Processbook and Coresight display capabilities for map
features.
Procedure

1. If necessary, access the link to the PI Integrator for Esri ArcGIS home screen and log in. 
If this is the first time you have started PI Integrator for Esri ArcGIS, the following message
displays:
You don't have any Services defined. Click here to add one.

If you have logged in and created services previously, a list of services is displayed. You can
change how the list of services is displayed by clicking either Table view or Tile view. Tile
view displays services in a series of boxes or "tiles," while Table view shows the services in
a table. See The Services Table view for more information.

2. Click the Create service button to add a new service. 
The Create new Geo Service page opens.

3. In the Name field, enter a name for the new service. 
Fields with an asterisk next to them are mandatory. Specify a name that contains a
minimum of five lowercase or uppercase alphanumeric characters, hyphens, or
underscores. You should choose a name that is easy to remember. The name is required and
must be unique. Do not use spaces or special characters in the name.

4. In the Description field, enter a description for the service.
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5. Check the StreamServer check box, the DisplayServer check box, or both, then click Create. 
The service is now created. and the details page of the service you just created are
displayed. If desired, you can create additional services, or configure the service by adding
layers, which is described in the following topics.

6. Click the Create button. 
The service is created and ready for configuration.

Results

The detail page for the newly created service opens. From this page you can create one or
more layers, and you can configure the StreamServer and the DisplayServer, which are covered
in the topics that follow.

The Services Table view

The Table view of the Services screen allows you to customize the display and configure
options. You can:
• Sort the list by Name alphabetically by clicking the Name heading.

Note:
For any of the columns that can be sorted, clicking the heading a second time reverses
the sort order. The sort order is indicated by an arrow; ascending sort is shown as:

, while descending is: . The presence of the arrow indicates the sorted column.

• Sort the list by Description alphabetically by clicking the Description heading.
• Sort the list by the date the service was created or modified.
• Sort the list numerically by the number of layers in each service by clicking the Layers

heading.
• Edit a Service name, Description, or StreamServer or DisplayServer properties by clicking

the pencil icon: .

• Delete a service by clicking the Delete icon: .
You can also create a new service by clicking the Create Service button.

Note:
You must first remove any layers defined within a service before the service can be
deleted.

View a summary of service connections

You can view a list of services that have had recent StreamServer connection activity.
Procedure

1. From any PI Integrator for Esri ArcGIS page, select Administration > Stream connections. 
A list of services that have recent StreamServer activity is shown. Each service can be
expanded or collapsed by clicking on the service name, or all of the services can be
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expanded by clicking Expand all. Expanding a service displays the layers defined for the
service, in addition to the following fields:
◦ Open connections

Connections that are active and currently streaming data.
◦ Closed connections

Connections that were closed gracefully by the client.
◦ Faulted connections

Connections that closed unexpectedly due to an error on the client, server, or the
network connection between the two.

◦ Total connections

A summary of all connection activity.
◦ Updates

The number of feature updates that were sent.
◦ Data

The total number of data bytes sent.
The display is refreshed automatically every ten seconds while the page is open; however,
you can manually refresh the page by clicking Refresh.
You can click on a layer name to link to its Layer Details page, where the individual
StreamServer connections are shown in detail.

Create a layer
PI Integrator for Esri ArcGIS provides a feature layer service that can expose an AF model's
elements and attributes as features enhanced with data fields. If PI assets are tagged with
geographical markers, these are exposed in the feature layer so that position points can be
rendered on the feature layer, or vector shapes defining regions can be drawn.
A layer defines a set of search parameters that are used to select elements in the AF database.
These AF elements will be represented as map features. A service can contain one or more
layers.
Procedure

1. Open one of the previously defined services by clicking on it in the PI Integrator for Esri
ArcGIS home screen. 
If you have not previously defined a layer, the following message displays:
You don't have any layers defined for this service. Click here to start
adding layers.

If you have previously defined one or more layers they are listed alphabetically on the
screen. See The Layers Table view for more information.

2. Click either the here link or the Create Layer button. 
The layer is created and ready for configuration.
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3. In the Name field, enter a name for the new layer. 
You can specify any name. You should select a name that is easy to remember. The name is
required and must be unique. In addition, the name must contain a minimum of five
characters. The Name field may contain only lowercase and uppercase alphanumeric
characters, hyphens, and underscores. Do not use spaces or special characters in the name.

4. Enter a description for the layer in the Description field.
5. Click the Continue button.
Results

Continue to the next topic to configure the layer with server, database, and element definitions.

Configure the layer

Before you start

Ensure that you are familiar with the name of the AF database you will use. Use PI System
Explorer to find AF servers, databases, and templates.
Procedure

1. In the AF Server drop-down list, select the AF server that you wish to use. 
The drop-down displays all of the AF Servers that are known to the PI Integrator for Esri
ArcGIS Data Relay. When you select an AF server, all of the databases defined on that server
are shown in the AF Database drop-down list. The servers must be defined in the servers
list in PI System Explorer.

2. In the AF Database drop-down list, select the AF database that you wish to use. 
When you select an AF database, all of the templates defined in that database are shown in
the Template drop-down list.

3. In the Template drop-down list, select the template you wish to use.
4. Optionally, specify information in the following fields:

a. In the Category drop-down list, select the AF element category that you wish to use. 
You use a category to classify AF elements in the layer. Refer to AF user manual for
information about creating PI AF categories. See Introduction to PI Asset Framework for
information about PI AF categories.

b. In the Max Count field, specify the maximum number of objects returned from a search.
Because some searches might return thousands or even tens of thousands of results, the
max count prevents bogging down the system by preventing large numbers of AF
elements being returned when performing a search. The number of search results is
limited to the number specified in the Max Count field.

c. In the Search root field, specify the starting node from which to search. 
The Search root field specifies where in the path the search should start. You can drill
down as far as you wish into the search path. A node is an element in a hierarchy in an
AF database which forms the root of a search. All elements below this node which are
derived from the selected template will be found.
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You can specify the search root node by clicking the Select button located next to the 
Search root field. You can traverse the database tree to locate and specify the starting
node from which to search.

5. Click the Continue button.
Results

After specifying the layer data you want to use, you can preview the data you have specified by
clicking the Preview button.
Continue to the next topic to configure the fields in the layer.

Configure the fields

You configure fields to determine which attributes to use. The Template attribute fields section
of the layer definition screen shows all of the attributes found using the AF template. See Field
configuration for more information about fields.
By default, the attributes are listed by attribute category. Uncheck the Show categories check
box to list elements alphabetically.
You must specify one of the fields as a key field. The key is a unique identifier field for a map
feature. Use the following steps to configure the fields in the layer definition.
Procedure

1. Specify whether the attribute is included, the attribute name, and the function for each of
the listed attributes. 

Caution:
OBJECTID is a reserved system name which cannot be used. The system might ask you
to rename any attributes that have reserved names. If so, you can make a simple
modification to the name such as adding a space (OBJECT ID) or adding a name (Esri
OBJECTID).

2. Press Continue when finished. 
A message is displayed if an error is found with the configuration. Fix the error and try
creating the layer again.

Results

After the layer is created, the details page of the layer is displayed. Continue to the next task to
run the ArcGIS Platform Wizard.

Specify element fields

An element contains more information than just attributes. You can select element fields such
as the following:

• Element name

The name of the element
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• Element path

The full path to the element
• GUID

A unique identifier for the element (usually used internally but may be exposed)
• Description

The element description
• Retrieval time

The timestamp at which the data was retrieved
• Template name

The template name
Procedure

1. Modify the attributes in the element fields section of the layer definition as desired.

Preview the layer data

After selecting the desired layer attributes, you can preview the data you have selected by
clicking the Preview button. The elements are displayed as an alphabetic list. You can sort the
list in reverse alphabetic order and you can perform a search within the data.
Procedure

1. Click the Preview button. 
You can sort the list by clicking either A - Z or Z - A. You can also search the element list by
entering a term in the Search box.

2. Close the preview screen to return to your layer.

Field configuration

The Field configuration shows the following fields:

• Included

All fields are included by default; however, you can improve performance by deselecting
unwanted fields or fields that will not be used. Transferring field data that is not used can
slow system performance. In addition, having fewer fields might make the list easier to
understand.
You can select the individual fields you want exposed in the Template attribute fields
section. Fields with a checkmark are used in the layer while those without a checkmark are
not. Remove the checkmark to remove the attribute from the layer.

• Name

The name field shows the name that will be used in the ArcGIS platform. The name can be
different from the attribute name specified in PI AF, if necessary, to make it easier for users
to understand.
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Attribute names must be composed from simple alphanumeric characters: A-Z, a-z, and 0-9
and underscore ( _ ). When the New Layer page opens, the AF attribute names are
converted automatically to simple alphanumeric characters. For example, characters with
diacritical marks are converted into the closest corresponding simple characters.
But they may then be edited further as desired. Validation cues will appear if the user
modifies an attribute name to contain invalid characters.

• Attribute Name

The name of the attribute as it appears in PI AF. The attribute name cannot be changed in
this screen.

• Type

The data type of the attribute.
• Source

The name of the AF data reference or static. The attribute source can be PI point,
calculation, or static.

• Units

The default measurement unit for the attribute.
• Function

The X and Y functions are pre-selected if the tool finds any attribute name that contains the
words longitude or latitude, or X or Y and assigns them to the x and y function. If desired,
you can select a different function (select None, X, Y, Key or Geometry). You specify X and Y
functions for attributes that indicate geographic positions, including positions that move
over time. Only one X and Y pair can be specified.
A field function defines a special function for the field value, which allows you to specify
those fields that make up the geometry (or location) of a map feature. You can select either
an X or a Y function, or select a geometry function.
◦ Specifying X and Y

By specifying the X and Y functions, you determine which values make up the location of
the map feature. For example, when you have longitude and latitude values defined in
your AF template, you can select the X function for longitude and Y for latitude. X and Y
must be defined in pairs; you cannot have an X value without a Y value and you cannot
have a Y value without an X value. X and Y function fields must be numeric.

◦ Specifying a geometry

Another geometry option is to specify the geometry or location on a map feature by
defining it in Esri Feature Geometry Json. See Esri geometry information (http://
webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=The_geometry_object) for
more information. Specifying a geometry allows for much more complex areas to be
defined, such as (poly)lines or polygons. Geometry function fields must be of type string.

◦ Specifying a key function

A key function specifies a unique identifier for a particular map feature. Use care to
ensure that the key function is unique for your configured search parameters when you
select a field. The key function is used when updating map features in a Feature Service,
and also to identify PI Coresight displays.
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Specify layer geometry

If your layer uses complex geometry (that is, if your geometry is defined by text that contains
Esri Feature Geometry Json instead of X and Y coordinates), you must specify the kind of
geometry that the layer displays. It is important that this field be specified correctly; if the
wrong geometry type is specified, your layer will appear incorrectly on maps.
Procedure

1. In the Geometry field, select the appropriate geometry from the drop-down list.
2. In the Spatial reference field, select the most appropriate coordinate system for the data

you intend to display. 
You can choose from among more than 5,000 coordinate systems. To make finding a
specific coordinate system easier, you can enter part of the name in the search box, which
limits the displayed coordinate systems to those that contain the search words. The number
in parentheses shown after the coordinate name is an ID assigned by Esri, called the well-
known ID. If you are familiar with coordinate systems you can simply enter the well-known
ID number.
The most widely used coordinate system is World Geodetic System 84, or WGS_1984, which
is the coordinate system used by most GPS receivers. WGS_1984 is the default coordinate
system when you create a layer with geometry. You should check with your GIS expert
about coordinate system to use.
To find out more about coordinate systems, see these Esri sites: Geographic coordinate
systems (http://resources.arcgis.com/en/help/main/10.1/index.html#//
003r00000006000000) and Projected coordinate systems (http://
resources.arcgis.com/en/help/main/10.1/index.html#/
What_are_projected_coordinate_systems/003r0000000p000000/).

3. Click the Create Layer button. 
The layer is created.

The Layers Table view

The Table view of the Layers screen allows you to customize the display and configure options.
You can:
• Sort the list by Name alphabetically by clicking the Name heading.

Note:
For any of the columns that can be sorted, clicking the heading a second time reverses
the sort order. The sort order is indicated by an arrow; ascending sort is shown as:

, while descending is: . The presence of the arrow indicates the sorted column.

• Sort the list by Description alphabetically by clicking the Description heading.
• Sort the list by the date the layer was created or modified.
• Sort the list numerically by the number of active connections by clicking the Active

connections heading.
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• Edit a Layer name or Description by clicking the pencil icon: .

• Delete a layer by clicking the Delete icon: .
You can also create a new layer by clicking the Create Layer button.

Run the ArcGIS Platform Wizard
When you finish defining the layer and click Connect, the layer is created and a window opens
asking whether to connect the layer to the ArcGIS platform. The ArcGIS Wizard makes it easy
to connect the newly created layer to the ArcGIS platform.

ArcGIS Platform Wizard prerequisites

Before starting the wizard, make sure you have the following:

• You must have an ArcGIS Online account or an ArcGIS Portal account that has privileges to
publish a hosted Feature Service.

• Your ArcGIS GeoEvent Processor is running and is configured as a known ArcGIS GeoEvent
Processor in PI Geo Services.

• You have administrator credentials for your ArcGIS GeoEvent Processor.
• Your ArcGIS Online account is registered as a Data Store in ArcGIS GeoEvent Processor.
• The GeoEvent Processor Manager certificate must be a trusted and valid certificate. You can

check whether the certificate is trusted by browsing to your GeoEvent Processor Manager.
Depending on your browser, a red lock icon with a warning message is displayed when the
certificate is not trusted.
You can either choose to trust the certificate in your browser or obtain and install a valid
certificate signed by a Certification Authority to be used with GeoEvent Processor.
To trust the certificate in Internet Explorer, see: ArcGIS GeoEvent Processor for Server
Install Guide for Windows (http://resources.arcgis.com/en/help/install-guides/arcgis-
geoevent-processor-windows/10.2/index.html#//02wn00000005000000).
For Google Chrome and Mozilla Firefox, follow similar product-specific steps to install a
valid certificate.
To install a certificate signed by a Certification Authority in GeoEvent Processor, see:
Optional: Replacing ArcGIS GeoEvent Processor for Server's self-signed certificate (http://
resources.arcgis.com/en/help/install-guides/arcgis-geoevent-processor-windows/10.2/
index.html#/
Optional_Replacing_ArcGIS_GeoEvent_Processor_for_Server_s_self_signed_certificate/
02wn00000004000000/).

ArcGIS Platform Wizard Feature Service Environment

GeoEvent Processor retrieves data from PI Integrator for Esri ArcGIS and outputs the data to a
Feature Service. You use the Feature Service to create a layer on a map. The Feature Service
can be hosted either in ArcGIS Online or on an ArcGIS Portal.
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Procedure

1. Select one of the following:
◦ ArcGIS Online to select the ArcGIS online server.
◦ ArcGIS Portal to select a local ArcGIS server.

Note:
If you select ArcGIS Online, you must have previously configured a Data Store that
points to ArcGIS online. If you click ArcGIS Portal, you must have previously
configured a server Data Store that points to your on-premise ArcGIS Portal server.
Feature Services that are stored in ArcGIS Online are not visible to ArcGIS Portal, and
Feature Services that are stored in ArcGIS Portal are not visible to ArcGIS Online. See
Esri documentation for more information about configuring Data Stores.

ArcGIS Online option

You use the ArcGIS online option to automatically create an ArcGIS Feature Service with the
appropriate schema. Follow the steps below to create the Feature Service.
Procedure

1. On the Publish an ArcGIS Online Feature Service screen, enter your User name and
password. 
The account credentials you use must have administrator privileges within the specified
organization.

Note:
You can use ArcGIS online to view and set the required permissions for each user. If
necessary, start ArcGIS Online and select the My Organization tab and modify
individual users as required.

2. Click Verify credentials. 
If the credentials are valid successful, the wizard shows a suggested Service and Layer name
with descriptions.

3. Enter a new Service name and Description or leave the default name and description. 
The layers defined for PI Integrator for Esri ArcGIS are similar to layers for ArcGIS.

4. Enter a new layer name and description or leave the default values.
5. Click Create Feature Service. 

When you select Create Feature Service, the service and layer are created in ArcGIS online.
If successful, the following message is displayed:
Feature Service created

You can log in to ArcGIS Online to view and change permissions on your new Feature
Service.
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Note:
Remember to set permissions accordingly to prevent the ArcGIS Online global
community from subscribing to your Feature Service.

6. Click Next to display the Configure GeoEvent Processor screen. Proceed to Share the Feature
Service publically for the next step.

ArcGIS Portal option

You use the ArcGIS Portal option to automatically create an ArcGIS Feature Service with the
appropriate schema. Follow the steps below to create the Feature Service.
Procedure

1. On the Create Feature Service screen, enter the URL of your local ArcGIS portal, your user
name, and password. 
The user name and password are for your local ArcGIS portal. The account credentials you
use must have administrator privileges.

2. Click the Verify credentials button. 
If the login credentials are correct, the wizard shows a suggested Service and Layer name
with descriptions. The Geometry Type and Spatial Reference coordinate system that you
selected previously are also displayed.

3. Enter a new Service name and Description, a new Layer Name and Description, or leave the
default names and descriptions as-is.

4. Click the Create button. 
When you select Create, the service and layer is created in ArcGIS online. If successful, the
following message is displayed:
Feature Service created

5. Click Next. The Configure GeoEvent Processor screen displays. Proceed to Share the Feature
Service publically for the next step.

Manually create a Feature Service

You can manually create an ArcGIS Feature Service. In the steps that follow, you download a
CSV (Comma-Separated Value) file and use it to publish the data to your ArcGIS server portal
to create a hosted Feature Service.
Procedure

1. Click I want to manually create a Feature Service link. 
A Download button displays.

2. Click the Download button to save the file.
3. After downloading the file click Next. 

Before you can continue with the wizard, the CSV file must be uploaded manually to the
ArcGIS portal.

4. Start your ArcGIS portal and click the My Content tab, then click Add Item. 
The Add Item screen displays.
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5. Click Browse, then select the CSV file that was downloaded previously and click Open.
6. In the Add Item screen, specify a tag in the Tag field. In the Location Fields column, ensure

that you have Latitude and Longitude fields specified in your data.
7. Click Add Item. If prompted, provide your login credentials to ArcGIS server. The data items

that were added to the ArcGIS portal are updated on the ArcGIS Server. ArcGIS Server uses
the information from the CSV file to create a Feature Service that you can use.

Allowing access to the Feature Service

After the Feature Service is created, you must select who should have access to it. Sharing the
Feature Service makes it visible to GeoEvent Processor. To make a Feature Service available
publically, follow the steps in Share the Feature Service publically.
If you have created a GeoEvent Processor Data Store by specifying the on-premises server
(portal) option and a token is not specified, then the ArcGIS Platform Wizard will not show
unpublished and unshared feature services that are hosted on your ArcGIS portal server. To
create a Feature Service and associate it with a specific account, follow the steps in Share the
Feature Service with a specific account.

Share the Feature Service publically

Follow the steps in this section to enable the Feature Service to be shared by everyone.
Procedure

1. Log in to either ArcGIS Portal or ArcGIS Online, depending on which service you are using.
2. If necessary, select My Content. 

The My Content screen displays
3. Find and click the Feature Service you just created.
4. When the Feature Service is displayed, click Share. 

The Share window displays.
5. In the Share window, check the boxes as appropriate to make the Feature Service available

to the audience that should have access to the Feature Service.
6. Click Ok. 

Proceed to ArcGIS Platform Wizard Configure GeoEvent Processor to continue.

Share the Feature Service with a specific account

Follow the steps in this section to share a Feature Service with a specific account. Sharing a
Feature Service with a specific account allows the Feature Service to be visible only to a
specific user and not visible to the public. You can always share the Feature Service with a
wider audience later.
Procedure

1. Log into ArcGIS GeoEvent Processor Manager.
2. Click the Site button.
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3. Click the Data Stores menu item. 
The Data Stores screen displays. The Registered ArcGIS Server section displays all
registered ArcGIS servers.

4. Click Register ArcGIS Server. The Register ArcGIS Server screen displays.
5. In the Name field, specify a hostname to register with GeoEvent Processor.
6. In the URL field, specify the URL of your ArcGIS server. 

Specify the same URL you use to log in to ArcGIS. After entering the URL, a set of
instructions displays that explain how to obtain a token.

7. Highlight and copy the HTTP referer parameter in the instructions.
8. Click the link after: To acquire a token, go to: 

A new tab opens in your browser named Generate Token.
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9. Enter your ArcGIS portal user ID and password.
10. Click the Webapp URL radio button then click Generate Token. 

The generated token screen displays.
11. Highlight and copy the entire token to your clipboard.
12. Return to the ArcGIS GeoEvent Processor Manager tab in your browser and paste the token

into the Token field.
13. Click Register. 

The server now appears in the list of registered ArcGIS servers.
14. In your browser, return to the ArcGIS Platform Wizard tab and click Refresh in the Data

Store section. 
The Data Store is displayed in the data store list. You might need to click the Refresh button.

15. Select the newly created Data Store and continue running the ArcGIS Platform Wizard.

ArcGIS Platform Wizard Configure GeoEvent Processor

After creating the Feature Service, you can connect the service to the GeoEvent Processor. The
Feature Service that was created previously is selected automatically if it is defined in the
selected Data Store.
Procedure

1. In the GeoEvent Processor field, select the appropriate GeoEvent Processor from the list. 
You can click the Manager button to open a new browser tab containing the ArcGIS
GeoEvent Processor Manager.

2. Enter your User ID and password for the GeoEvent Processor and click Validate credentials.

After you credentials are verified, the wizard connects to the GeoEvent Processor and
retrieves information about all ArcGIS servers that are configured. The GeoEvent Processor
that was selected is displayed. You can change to a different GeoEvent Processor by
clicking: Click here to change your connection.

3. In the Data Store field, select the Data Store that is configured in your GeoEvent Processor.
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4. In the Folder field, select folder where your Feature Service is stored. The folder is normally
the root directory, specified by entering "/".

5. In the Service field, select the Feature Service that contains the layer you want to update
with data. 
The name of the Feature Service should correspond with the Feature Service that was
created in previous steps.

Note:
The screen is refreshed automatically until the Feature Service that you created
earlier is selected. Click the Refresh button manually if the Feature Service is not
selected automatically. A spinning loader icon displays when a refresh is in progress.
An ok icon displays when the Feature Service and layer are selected.
You must select the correct Data Store for the screen to refresh automatically. Use the
Data Store that corresponds with the credentials that were entered earlier when the
Feature Service was created.

6. In the Service Layer field, select the layer that you want updated with data. The name
should correspond to the Feature layer that was created earlier.

7. Check the Use Secure Websockets check box . See Configure a secure WebSocket for more
information.

8. Click Next.

ArcGIS Platform Wizard Advanced Settings

You can modify several settings on the Advanced Settings screen. Default values for each of the
fields are provided.
GeoEvent Processor works by taking an input from PI Integrator for Esri ArcGIS, and
connecting it with a Feature Service output. How the input and output are related is
determined by the Service. At the simplest level, a service simply connects an input to an
output.
Procedure

1. In the Input, Output, and Service fields, verify that the appropriate input, output, and
service values are displayed. If not, change as appropriate. 

Note:
Default names are provided for the input, output, and service name fields. You can
change the names as desired; however, the names should contain only letters,
numbers, hyphens and underscores. Avoid using spaces and special characters such as
&, ^, or %.
The minimum length for each field is five characters, and the maximum length is 200
characters. All three fields are required to have valid names before continuing. A
message is displayed when an input is incorrect.
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Caution:
The wizard uses the names in the Input, Output, and Service fields to store
information. If any of those names already exist, they will be overwritten by the
wizard when you click the Create Service button.

2. In the Identity (key) Field, verify that the default data is appropriate. If not, change it as
appropriate. 
By default, the element that was selected as the key is entered into the Identity (key) Field.
You have the option of using a different field if desired.

3. In the Refresh Interval field, specify (in seconds) how often the GeoEvent Processor polls
the configuration portal for new data. The default refresh interval is 5 seconds.

4. In the Session Inactivity Timeout box, specify the amount of time that must elapse before
the connection between the GeoEvent Processor and the Configuration Portal is considered
closed. The activity timeout helps manage resources on the Data Relay. When the GeoEvent
Processor begins polling again, data flow resumes seamlessly. The inactivity timeout should
generally be several times greater than the poll interval. 
The default session inactivity timeout period is 300 seconds (5 minutes).

5. Check Send latest values only to specify the nature of the data updates that are returned
when the GeoEvent Processor polls for data. When enabled, only the latest value of each
updated Feature (Asset) is returned, which greatly reduces the load on all systems involved.
When disabled, all intermediate values are also returned, which is desirable if performing
analytics in the GEP and intermediate values are necessary. 
Send latest values only is selected by default.

6. Check Use HTTPS (secure) to specify whether all data is transmitted securely. Using HTTPS
requires performing a one-time security configuration on the GeoEvent Processor before
data can flow back and forth.

7. Click Create Service. 
If the service was created without errors, the following message is displayed:
Service created

8. Click Next. The following message is displayed:
You can always repeat this process to create additional feeds.

9. Click Finish. After clicking the Finish button, the service is created within GeoEvent
Processor and then a Summary screen is displayed.

Results

The Summary screen shows a summary of what was done in the previous steps. You should
ensure the following:
• A connection from your ArcGIS GeoEvent Processor is made to this Stream Server endpoint,

which is displayed when the wizard is closed.
• Your ArcGIS GeoEvent Processor is receiving events from PI Integrator for Esri ArcGIS. Use

the ArcGIS GeoEvent Manager to check whether events are received.
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Map and layer configuration
The following topics show how to create and configure maps so that geographic information
about your PI assets is displayed. You can customize the map and the way in which
information is shown on the map

Create a map
You create a map to display the geographic positions of your PI assets.
Procedure

1. Log in to ArcGIS online and click the Map menu item. 
A base map is displayed. You can select all or part of the map you want to use, and decide
what should be shown on the map. Create a map using the following four steps:
◦ Step 1: Choose an area.

You can pan and zoom the map to display a specific area or you can search for a name or
address.

◦ Step 2: Decide what to show.

Click the Basemap menu item then select one of the base maps to use. Add layers to the
map by clicking the Add menu item and selecting one or more layers. You can select pre-
defined Esri map layers, add a layer from the Web or a file, or add map notes. If you have
already defined one or more Feature Service layers, you can add them here.

◦ Step 3: Add more to your map.

Click the Add menu item and select map notes to add static map features such as private
buildings or roads.

◦ Step 4: Save and share your map.

Save your map by clicking the disk icon and choosing Save as and provide a map title,
tags, a summary of what the map contains, and the location in which to save the map.
Next, click the Share menu item and choose who can view the map.
Note the link URL you can use to display the map on the Web.

2. Add one or more of the layers you created previously by clicking the Add menu item and
selecting Search for layers. 
A list of layers that you created is displayed.

3. Enter a search term, find your map, and click Add. 
Don't forget to save your map and to update the sharing information.
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Create a pop-up
Each symbol on your map represents a physical object. When you click a symbol on a map, a
pop-up is displayed. You can edit the pop-up to include a link to your PI Coresight server,
allowing you to monitor real-time information about that asset. The specific information
shown depends on the fields selected when the layer was created. You can link a symbol to a PI
Coresight server, then the pop-up will contain a link to a PI Coresight display.
Before you start

Ensure that you have configured a PI Coresight endpoint (see Configure PI Coresight server
endpoint for more information).
Procedure

1. Open your map in ArcGIS.
2. Select one of the layers by clicking it. 

A drop-down list appears next to the selected layer.
3. Select Configure Pop-up from the drop-down list. 

A list of pop-up properties is displayed.
4. Select Image from the ADD drop-down list in the Pop-up Media section.
5. In the Configure Image window, enter a Title, Caption, and URL to use for the pop-up image.

The URL should point to an image. The image will appear in the pop-up and will act as a link
to your PI Coresight server. You should use the same link that was configured when you set
up PI Coresight (see Configure PI Coresight).

6. In the Link field, enter the link to the Coresight server using the same URL as was entered in
the Ad hoc display field (see Configure PI Coresight). 
Now, when the pop-up is clicked, it will contain the image that was configured in step 5.
Clicking the image in the pop-up will link to your PI Coresight server display.

Create and customize symbols
By default, the symbols or map features on your map display as red dots. You can modify the
symbols to make them more visually accurate or appealing.
Procedure

1. Open your map in ArcGIS.
2. Select one of the layers by clicking it. 

A drop-down list appears next to the selected layer.
3. Select Change Symbols from the drop-down list. 

The Change Symbols menu is displayed.
4. Select Change Symbols from the Options drop-down list. 

The Change Symbols window opens.
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5. Choose a symbol category from the drop-down list. 
The Basic category is displayed by default. Several categories are available to choose from,
including Business, General infrastructure, and Travel.

6. Adjust the size of the symbol as necessary Symbol size using the slider, or by entering the
pixel size in the px box.

7. Click the Apply button to preview the symbol, then click the Done button when finished. 
Click the Cancel button if you want to ignore your changes.
You can also select one of the attributes in the map and assign a range of colors to it. The
symbol will change color based on the value of the attribute obtained from the PI Data
Archive.

Configure PI Coresight

Before you start

Ensure that the PI Coresight server endpoint has been configured. See Configure PI Coresight
server endpoint.
Procedure

1. In PI Integrator for Esri ArcGIS, select the Layer for which you want to display PI Coresight
data, then click the DisplayServer button at the bottom of the screen. 
The Configure Display Server screen is displayed. All of the fields contain default values.

2. In the Display server configuration section, verify or change the default value in the PI
Coresight Server drop-down list. 
If you have multiple PI Coresight servers configured you can select the one you want to use.

3. In the Sharing section, enter the URLs of images to display in the Ad hoc display, the 
AFdButton Image field, the OSIsoft Button Image field, and the Coresight Button Image
field.
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Utilities

Asset Extractor
The Asset Extractor is a tool you can use to read assets within a feature layer and insert those
assets into your PI System.
Two versions of the Asset Extractor are available: an online version and a downloadable
version. The desktop version can extract features from map layers hosted on secure map
services (HTTPS) and unsecured map services (HTTP), and can handle larger amounts of data.
The online version is accessed directly from the PI Integrator for Esri ArcGIS Portal, and is
often the easiest version to use. However, the online version does not support the extraction of
data from map layers that are hosted on unsecured map services; only secure map services are
supported. In addition, the online version is unable to extract features from very large map
layers. If you attempt to extract large amounts of data or to extract data from a non-secure map
service, you will be prompted to download and use the desktop version. The desktop version is
available for Windows Vista and later versions and does not require installation.
If you are an Esri ArcGIS user and you are just getting started with the PI System, you probably
have assets that are defined in ArcGIS but not in the PI System. While ArcGIS assets consist
mostly of metadata such as location information, PI System assets might include data and
analytics from the PI System in addition to metadata. You use PI Integrator for Esri ArcGIS to
augment and enrich PI assets. To use PI Integrator for Esri ArcGIS effectively, you must have
rich PI Assets which expose PI System data. You use the Asset Extractor as the first step
towards converting your existing Esri ArcGIS asset metadata and getting started building rich
assets in the PI System.
The Asset Extractor will read and include any geometry information that is included with the
target Map Layer. This includes the feature shape, the feature shape type (Point, Polygon, and
so on), and coordinate systems. These fields are placed in an AF category called Geometry. For
geometries of type Point, values for Latitude and Longitude are included. Note that in some
cases, the Attribute names of Latitude and Longitude and the default unit of measure of
degrees might not apply. You must modify these fields manually in PI Asset Framework as
necessary. Any existing fields (that is, if your map layer already has a field called Latitude)
are not overwritten; the Extractor-generated fields are given a unique name such as
Latitude1. You should choose which fields to keep and use; you can also rename fields as
appropriate.

Run the Asset Extractor

You use Asset Extractor to read assets automatically from a feature layer endpoint (URL) so
they can be added to your PI System. The endpoint must be the address of an Esri ArcGIS
Feature Layer that has been exposed using MapServer or FeatureServer. If desired, you can
include an Esri-designed query into the endpoint to limit the elements that are selected. For
example, you could select all of the elements within a certain city, state, or region rather than
all of the elements that exist within a country.

PI Integrator for Esri® ArcGIS® 1.0 User Guide Beta 3  47



Procedure

1. If necessary, start PI Integrator for Esri ArcGIS and select Asset Extractor from the Tools
menu.

2. In the Address field, enter a MapServer or FeatureServer address (endpoint). 
The endpoint must point to one specific map layer. A valid endpoint URL must point to a
MapServer or FeatureServer, and can optionally contain an embedded Esri query.
If desired, you can enter advanced mode by clicking the link: Or, manually provide feature
JSON (advanced). In advanced mode, you can paste the Esri layer definition and feature
definition JSON.

3. Click Apply. 
The features are loaded into pages, and the status of the extract is displayed. Be aware that
large layers might take a long time to load and can heavily tax the web browser.

4. Click Next. 
The AF output preferences page is displayed.

5. In the listbox, select the feature attribute that should be used as the Asset Framework (AF)
Element name. 
The name must be a unique field, and it should be a descriptive field; that is, something
which is not overly cryptic, if possible. Note that you can always rename fields later using PI
Builder for Excel. Remember that the element names must be unique.

6. Click Next. 
The Download AF Elements screen is displayed.

7. Click Download. 
The download file contains XML and is named {name} database.xml.

Results

The downloaded file is ready for import into PI Asset Framework.
Use PI System Explorer to import the file into a new Asset Framework database. In PI AF,
select File > Import from File.
You can then enrich the assets by adding data, analytics, and other metadata. If any attribute
created by the Asset Extractor maps to real-time data, you should (as administrator) edit the
Attribute to use the PI Point Data Reference to point to a PI tag.
For more information, see the Asset Framework instructional materials and courses.

Desktop version of Asset Extractor
You use the desktop version of PI Asset Extractor when the layer you want to extract contains
thousands of features, or if your map server is situated at an unsecured site. Sites that start
with https are secure while those that start with http are not secure.
The desktop version of the Asset Extractor is compatible with Windows Vista and later
versions. To use it, you download the zip file and extract it to a convenient location.
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Download and extract the program

The downloadable package is a .ZIP archive that contains the Asset Extractor application. To
access the application, you must first download it from the PI Integrator for Esri ArcGIS Portal,
and then extract its files.
Procedure

1. From the PI Integrator for Esri ArcGIS home screen, select the Tools menu item. 
The Tools screen is displayed.

2. Click the Asset Extractor tile. 
The extractor page is displayed.

3. Click the text: Desktop edition also available for download. 
The section expands to display the Download desktop edition button.

4. Click the Download desktop edition button. 
Follow your browser's instructions for downloading the file.

5. Using Windows Explorer, navigate to the directory in which the file was downloaded. If
desired, you can extract the file contents from the download directory, or copy the .ZIP file
to another directory.

6. Right-click the .ZIP file and select Extract all. 
Note the location of the extracted files before proceeding to the next section.

Run the desktop Asset Extractor

After the application is downloaded and extracted, it is ready to be run. No installation is
required other than extracting the executable program from the .ZIP archive. Although it is
possible to retain the files for future use, it is recommended that you download the latest
version from the Portal each time you use the Asset Extractor.
Procedure

1. Navigate to the directory in which the Asset Extractor files were extracted from the .ZIP file.
2. Double click the executable file: PI Asset Extractor for Esri ArcGIS.exe. 

The PI Asset Extractor for Esri ArcGIS window opens.
You might receive an application run security warning when opening the extractor. Click 
Run.

3. In the PI Integrator for Esri ArcGIS window, enter the address of the layer that you want to
extract. 
You should enter the address of an ArcGIS Feature Layer. The feature layer should be
exposed using the MapServer or FeatureServer. You can include an Esri-specific query to
restrict elements to a specified element subset. For example, if you are extracting oil well
data, you might want to restrict the query to show only wells that are located in a particular
state.

4. Click Load features. 
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If successful, the following message is displayed:
Features loaded! Choose the desired Asset Name and you're ready to
generate the XML export.

5. From the drop-down list of asset names, select the asset name to use to generate the XML.
When finished, click Save as XML. 
The Save As window opens.

6. Specify a file name in which to save the XML data. 
The data is now ready for use. You can exit from the application by clicking the close icon.

Utilities
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Administrator roles and definitions
Throughout the steps in this document for configuring PI Integrator for Esri ArcGIS, you might
be required to have one or more administrator accounts. This section describes each
administrator role, what you need it for, and how to obtain administrator access.

• ArcGIS administrator

The ArcGIS administrator is responsible for performing necessary ArcGIS setup tasks, and
for ensuring proper permissions to publish content to the Esri GeoEvent Processor.
You need ArcGIS administrator privileges in order to configure ArcGIS.
You can obtain ArcGIS administrator privileges from an existing ArcGIS administrator
within your organization.

• PI Integrator for Esri ArcGIS administrator

The PI Integrator for Esri ArcGIS administrator is responsible for user account management
and Data Relay configuration.
You need PI Integrator for Esri ArcGIS administrator privileges in order to view
administrative pages such as account management and Data Relay configuration.
You can obtain PI Integrator for Esri ArcGIS administrator privileges from an existing
administrator. In the Cloud version of the software, the first user to sign up for PI Integrator
for Esri ArcGIS is made an administrator automatically. In the on-premises version of the
software, the user who installs the Portal is made an administrator automatically.

• local system administrator

The local system administrator is responsible for installing necessary software pieces, such
as the Data Relay.
You need local system administrator privileges in order to install software.
You can obtain local system administrator privileges, or identify someone who has them, by
working with your IT department.
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Security and system administration
You use PI Cloud security administration tools to maintain user and user account information.
Refer to the PI Cloud Security manual for additional information.
You can perform limited account administration using PI Integrator for Esri ArcGIS.

1. If necessary, start PI Integrator for Esri ArcGIS and select Account from the Administration
menu.
The Account option is visible only if you are an account administrator. The Service Bus
information is configured per account.
The first person within an organization to log in is designated as the PI Integrator for Esri
ArcGIS administrator. The administrator can designate additional administrators from the
screen in this step.

2. Click the Manage Users button to grant or revoke administrator privileges to individual
users.

Configure a user for on-premises version

The on-premises application is identical to Azure cloud environment except for how user
access rights are managed. On-premises security is based on Windows authentication and user
management is performed within Windows.
The installation program creates two local security groups, named PI Geo Admins and PI
Geo Users. To use the on-premises version of PI Integrator for Esri ArcGIS, users must be a
member of either of the security groups. The first user to install the Portal at your site is placed
in the PI Geo Admins group automatically.
Your administrator can add users individually or can add subgroups of users that share access
rights.
To access the Portal of the on-premises version, each user's Windows account must be placed
in the PI Geo Users and/or PI Geo Admins group, or must belong to an Active Directory
group which in turn has PI Geo permissions. Users and administrators have the same
permissions, except that administrators are permitted to open the Data Relay page.
Administrators of PI Integrator for Esri ArcGIS can add users and groups from Active Directory
into the authorized lists for Users and Administrators. It is recommended that you use existing
Active Directory groups wherever possible, rather than managing users individually.
Procedure

1. As a Windows administrator, start the Local Users and Groups management console
(lusrmgr).

2. Navigate to the Groups collection, and open the PI Geo Users or PI Geo Admins group.
3. Use the standard Windows account search and selection controls to add users or groups.
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Troubleshooting
Use the topics that follow to troubleshoot problems that you encounter while using PI
Integrator for Esri ArcGIS.

Problems configuring the Data Relay service

• The Data Relay service is installed and running, but the Portal says it is not
running.

The Data Relay creates log files in %ProgramData%\OSIsoft\Integrators\Esri\Logs
that you can use to aid in troubleshooting. A new log file is created daily when the service is
running. Locate the current log file and refer to the following sections.
◦ Mode of operation

When the Data Relay service is initialized, a line is written in the log file that says: 
Initializing service for {local or cloud} operation. If the Configuration
Portal is hosted in the cloud, ensure that the Data Relay service is installed in cloud
mode. If the Configuration Portal is installed locally, ensure that the Data Relay service is
installed in on-premises mode. Reinstall the Data Relay if it is installed incorrectly.

◦ Network and security
Follow the version-specific instructions as shown below:
▪ On-premises version

When running in on-premises mode, Data Relay logs all connections made from the
Portal, and should identify them as either successful or unsuccessful. If no connection
attempts appear, it is likely that problems with the network are terminating the
connection attempt before it reaches the Data Relay service. If connection attempts
appear but are unsuccessful, you must check the security configuration as outlined
below.
◦ Network

If the Data Relay log indicates that there are no connection attempts, ensure that
Port 5464 is unblocked on the Data Relay node. If you encounter problems with the
port and you want the Data Relay node to use a custom port, then contact OSIsoft
Technical Support.

◦ Security
If the Data Relay log indicates that connections are rejected, verify that the Data
Relay node and the Configuration Portal are installed on the same Windows
Domain, or on Domains that trust each other. Ensuring the domains trust each
other is a necessity, because Windows security is the only security mechanism
offered.
When you install the Data Relay node, you are asked to supply the Portal
identity, or the Windows account under which the Portal is running. This
Windows account must match exactly with what the Portal lists on the
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Configuration Settings page under Administration > Data Relay. The setting is
stored in the Data Relay's app.config file, which is located in the directory where
the application was installed. To change the setting, you may either reinstall the
Data Relay (recommended) or manually edit the app.config file (advanced).

▪ Cloud version
When initializing in Cloud mode, the Data Relay service logs connection attempts to
the Microsoft Azure Service Bus. If the connection is unsuccessful, messages similar to
the following are logged:
Failed to open server: Unable to reach
mycompany.servicebus.windows.net

If the log contains messages similar to the above, you should verify the following:
◦ That outbound traffic is allowed as required by the Data Relay, or that, if necessary,

the service has been configured to use your organization's proxy server.
◦ That the Data Relay node is using the correct configuration values. The values are

written to the log when the service starts. Confirm that the values match exactly the
configuration values given on the Administration > Data Relay page of the
Configuration Portal. If they do not match exactly, you can either reinstall the Data
Relay service (recommended) or manually edit the app.config file (advanced).

Problems when installing the Configuration Portal

• Navigating to the Configuration Portal site gives an "SSL error" page

Add an HTTPS binding to the IIS Website that is hosting the Configuration Portal, as
detailed in the prerequisites of the Portal Installation section of this manual.

• Navigating to the Configuration Portal site gives a server error page

Ensure that all IIS Role Services are installed properly as detailed in the prerequisites of the
Configuration Portal Installation section of this manual.
Ensure that your SQL Server is still online, and still accessible from the machine that is
hosting the Configuration Portal site.

Problems when creating a layer

• The Data Source section doesn’t contain any AF Servers

Check that there is a banner near the top of the page that says:
Your Data Relay node is running.

If the above message is missing, or if the following message is displayed, then you must
resolve this issue before proceeding to create a map layer:
You do not have a PI Integrator for Esri ArcGIS Data Relay installed,
properly configured or running
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The machine running the Data Relay node maintains a list of known PI AF servers. Ensure
that all desired PI AF servers have been added to the known servers list.

• The Data Source section does not update or refresh if I choose certain AF
Servers

Check your PI AF security. The Data Relay service runs as a Windows service account, which
is the account used when connecting to PI. The account must have read privileges to the PI
AF Servers and to the PI Data Archive Servers you intend to use within map layers.
When attempting to connect to AF, problems with security are not shown to users but they
are logged by the Data Relay service. The Data Relay creates log files that can help in
troubleshooting security problems. Log files are stored in the following location:
%ProgramData%\OSIsoft\Integrators\Esri\Logs

Problems publishing to ArcGIS
Often, failures encountered while running the Configuration Wizard are caused by failing to
ensure that all of the prerequisites are followed when the Configuration Wizard opens. Please
ensure that you have checked each of the prerequisite steps; failing to verify even a single
prerequisite can prevent the Configuration Wizard from succeeding.
Certain more specific failure reasons or unexpected behaviors are detailed below.

• Wizard, Step 2: I cannot connect to my on-premises ArcGIS Portal

Attempt to navigate to your ArcGIS Portal administration site using your web browser. If
the portal address does not begin with https://, try navigating to the same site using the 
https:// prefix. You must be able to access the Configuration Wizard using https://
prefix to successfully communicate with the ArcGIS Portal. If you cannot navigate to the
portal, you must configure your ArcGIS Portal to be available using HTTPS.

• Wizard, Step 3: I cannot connect to the GeoEvent Processor

Attempt to navigate to the GeoEvent Processor administration page using your web
browser. If the address cannot be resolved, then you must troubleshoot GeoEvent Processor
availability. If the address can be resolved, but your web browser warns you about its
security certificate, the Configuration Wizard will be unable to connect to the GeoEvent
Processor. Follow one of these steps.
◦ Instruct your computer to trust the certificate being used by the GeoEvent Processor. See

Esri ArcGIS help (http://resources.arcgis.com/en/help/install-guides/arcgis-geoevent-
processor-windows/10.2/index.html#/
Optional_Marking_the_self_signed_ArcGIS_GeoEvent_Processor_for_Server_certificate_as_
trusted_by_Internet_Explorer/02wn00000005000000/).

◦ Configure the GeoEvent Processor to use an already-trusted certificate, such as one
generated by your Windows domain. See Esri ArcGIS help (http://
resources.arcgis.com/en/help/install-guides/arcgis-geoevent-processor-windows/10.2/
index.html#/
Optional_Replacing_the_ArcGIS_GeoEvent_Processor_for_Server_self_signed_certificate/
02wn00000004000000/).
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• Wizard, Step 3: The Feature Service I created in the previous step isn't
available to be selected

Ensure that a Data Store has been configured in the GeoEvent Processor, and that this Data
Store corresponds to the proper ArcGIS Online account, or ArcGIS Portal server.
If you are using ArcGIS Online, ensure that your account has Administrator privileges
within your organization.
After new Feature Services are added, the GeoEvent Processor service sometimes requires
restarting to properly read from the Data Store. On the machine hosting the GeoEvent
Processor, restart the GeoEvent Processor system service. Then, from step 3 in the Wizard,
click Refresh next to the Data Store field. The list should now refresh properly, and should
contain your newly created target Feature Service.

Problems validating a connection to Esri ArcGIS

• How do I test my map layer to see what data will stream?

In the Configuration Portal of PI Integrator for Esri ArcGIS, navigate to your map layer and
follow the link: View in services directory: StreamServer. The resulting page
allows you to stream updates from the map layer. The initial state of the StreamServer is
displayed when the connection is opened. After opening the connection, you should see all
of the current features and associated values
Descriptions of fields in the StreamServer screen:
◦ Updates

The number of feature updates that were transmitted. An update is defined as one
payload of values.

◦ Total data

The total file size of these feature updates.
◦ Host

The IP address of the Portal server.
◦ Address

The IP of the recipient (typically, the GeoEvent Processor).
◦ Secure

Shows whether using WSS or not.
◦ Created

The amount of time that has passed since the connection was opened.
◦ Updated

The amount of time that has passed since the last feature update was transmitted.
◦ Total time

The difference between the time of the last update and the time of creation.
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◦ Time since last

For open connections, the difference between the current time and the time of the last
update.

◦ Average update rate

The update count divided by the total time.
◦ Average update data rate

The total data divided by the total time.
• My map layer won’t stream anything in test; the connection simply closes

◦ On-premises
Confirm that the web server that is hosting the Configuration Portal has the WebSocket
Protocol Role Service installed in IIS. The server cannot stream data without the
service.
Also, confirm that the pigeoportal IIS Web Application has both Anonymous
Authentication and Windows Authentication set to "Enabled" on the web server that is
hosting the Configuration Portal. Both authentication settings are required. All other
forms of authentication should be set to "Disabled." You use the IIS Manager console to
modify these IIS settings.

◦ Cloud and on-premises Data Relay
Navigate to Administration > Data Relay, or, if you are not an administrator, the page for
creating a new layer will show the same information. A banner shows status information
for the Data Relay service. If the Data Relay service is not connected, refer to that section
of this troubleshooting guide.
If the Data Relay is connected, examine the Data Relay logs for any sign of failures to
connect to PI Asset Framework and load elements and data.

• How do I know if the GeoEvent Processor is connected to my map layer?

In the Configuration Portal of PI Integrator for Esri ArcGIS, navigate to your map layer and
choose the StreamServer tab. Here, you can see all recent connections to the map layer.

• In the Esri ArcGIS GeoEvent Processor Manager, my newly created input
status is set to UNAVAILABLE

Navigate to the Inputs section of the Esri ArcGIS GeoEvent Processor and check whether the
following message displays:
UNAVAILABLE - No transport available matching this name/version:
com.esri.gep.transport.inbound/WssInboundTransport/10.2.1
This error message means that you have not properly installed the custom wss transport
for ArcGIS GeoEvent Processor. See Configure a secure WebSocket for information about
how to install the custom WebSocket transport.

• How do I see high-level statistics about connections to my map layers?

In the Configuration Portal of PI Integrator for Esri ArcGIS, navigate in the main toolbar to 
Administration > Connections. Layers with recent connections are shown.
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• On the map, some of my assets/features are missing

If this is a layer with thousands of assets or features, you might be encountering the feature
count limit which is, by default, set very low during layer creation.
By default, when you create a map layer, the maximum count of map features is limited to
1000. If you wish to see more than 1000 map features in your layer, this limit must be set to
a suitably high number such as 1,000,000. Currently, the only way to change this value is to
recreate the map layer.

• On the map, certain data fields never update with valid values

All data fields correspond to element attributes in PI AF. For the asset in question, find its
corresponding PI AF element, and locate the element attribute(s) that are not updating
properly. Look at the configuration for the Element Attribute to see which Data Reference is
selected and refer to the following:
◦ PI Point

If PI Point data is not updating, it is usually due to problems with security or server
registration.
Determine which PI Data Archive server contains the PI Point in question, and ensure
that the PI Data Archive server is added to the Data Relay machine's PI Known Servers
Table. Otherwise, the server will be inaccessible by the Data Relay.
Ensure that the service account used by the Data Relay service has security permissions
on the PI Data Archive server for all desired PI Points. Security configuration in the PI
Data Archive is selectable on a per-point basis; however, read-only security identity is
available which will suffice if more granular security is not warranted. In this simple
case, it is sufficient to create a mapping for the Data Relay service account to the PI
World identity using PI System Management Tools.

◦ Anything other than PI Point
If the attribute references PI Point data in any way (for example: if it is a formula that
uses PI Point data as an input, or a formula that depends on another formula that does
use PI Point data as an input), then the follow the steps about security in the previous
bullet.
If the attribute does not reference PI Point data in any way, then it is likely that the
attribute will not be able to trigger data updates to Esri ArcGIS. Data updates to Esri
ArcGIS are triggered individually for each PI AF Element when any of its trigger-capable
attributes receives new data. This usually means that Data updates to Esri ArcGIS are
triggered when any of its attributes reference a PI Point, and that PI Point has new data
events. However, when data updates are triggered, then all requested attribute values
are included in the update, even if they did not play a part in triggering the update.

Monitor data flow into the GeoEvent Processor
Use the steps in this topic to monitor the flow of data from your Feature Service to GeoEvent
Processor.
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Procedure

1. Open Esri ArcGIS GeoEvent Processor Manager and, if necessary, click the Services button
in the top menu and then click the Monitor button.

2. Find your service in the GeoEvent Services section of the page. The status of the GeoEvent
Service should be Started. The event flow rates on the In and Out lines should be the same.

3. Open the PI Integrator for Esri ArcGIS Portal in a different browser window and perform
the following steps:
a. Click your Feature Service, then select a layer within the Feature Service and click the All

tab.
b. Scroll to the Layer connections section of the page and verify that the Average data rate

(shown as Avg data rate) matches the rate shown in the Input section of the Monitor
page in GeoEvent Processor Manager.

Data Relay message log
The Data Relay service writes errors, status, and certain summary information to text logs on
the machine where it is installed. This information is helpful during troubleshooting and when
working with OSIsoft Technical Support.
The log files are located in:
%ProgramData%\OSIsoft\Integrators\Esri\Logs

Log files are never deleted automatically. You can delete old log files manually to save space;
however, it is recommended that you retain as many logs as possible should the need for
troubleshooting arise.
Log files are created as necessary whenever the Data Relay is running. The naming convention
for log files is:
YYYY-MM-DD.log

Note:
Uninstalling the Data Relay does not delete the log folder or its contents. You can remove
the folder manually after uninstalling the Data Relay.

Portal event log
The PI Integrator for Esri ArcGIS portal records certain events to an event log which you can
use to troubleshoot the software.
The Portal software might display a warning ribbon to alert you to check the event log. The
warning ribbon displays when any error with severity of Warning or higher has occurred
within the past 24 hours. You can prevent certain of the warnings from displaying by
acknowledging the error from within the event log. Other errors are closed automatically as
soon as the error condition is resolved. For example, if no Data Relay is active, a message is
logged with a status of Ongoing. The message status is set to Closed after a Data Relay becomes
active. The warning ribbon is displayed as long as there are active or unacknowledged errors
that have occurred within the past day.
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On the log viewer page, several filter fields are populated with default values. You might want
to change these values:
• Log level

Use Log level to filter events that are as severe or more severe than the chosen level. This
can eliminate "noise" from the log message if you want to view only events of a certain
importance. In order of descending importance, the levels are: Fatal Error, Error, Warning,
Information, and Debug.

• Start time and End time

Start time and End time are specified in any valid PI Time syntax, and control the bounds of
the log messages returned during search.

• Filter

Filter allows you to return only log messages which include certain key word(s) in their
content.

• Service and Layer

The search may also be confined to messages that are tied to a specific Service or Layer.
The log entries found by the search also include a Status column. For error conditions that
are active-until-closed (such as errors that occur when there is no active Data Relay node), the
Status column identifies whether the error is Ongoing or Closed. For error conditions that do
not signal an ongoing condition (such as a security error encountered by a user), the Status
column allows recent messages to be acknowledged by Configuration Portal administrators.
The sole effect and purpose of acknowledgement is to suppress the message from triggering an
alert banner after administrators become aware of the error. Messages older than one day do
not trigger an alert banner and do not require or permit acknowledgement.

View the Portal event log

You can search for errors reported by examining the event log. The event log is accessible from
the PI Integrator for Esri ArcGIS menu.
Procedure

1. From the PI Integrator for Esri ArcGIS menu, select Administration > Event log 
The Search events screen displays.

2. In each of the input fields, specify your search parameters then click Search. 
In the Start and End fields, clicking the asterisk ( * ) displays a calendar with the current
date and time selected. To choose a date and time other than the default, select the desired
date and time on the calendar.
To search for errors that were generated by a particular service, select the appropriate
service in the Service list. After selecting a service, the layers defined within that service are
displayed in the Layer list.
The results of the search are displayed on the page. If the search results in no events found,
the following message displays:
No search results
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If you do not see messages as expected, you should verify that you are not over-restricting
the Log Level (severity) or the time boundaries.

After you finish

In the event that no data is flowing to the PI Integrator for Esri ArcGIS portal, see Data Relay
message log for additional troubleshooting information.
You can export search results to a CSV (comma-separated values) file. For example, you might
want to export a list of events to send to OSIsoft Technical Support if you encounter technical
problems. Click Download after specifying valid search criteria to save the search results to a
file.
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Technical support and other resources
For technical assistance, contact OSIsoft Technical Support at +1 510-297-5828 or through the
OSIsoft Tech Support Contact Us page (https://techsupport.osisoft.com/Contact-Us/). The
website offers additional contact options for customers outside of the United States.
When you contact OSIsoft Technical Support, be prepared to provide this information:
• Product name, version, and build numbers
• Details about your computer platform (CPU type, operating system, and version number)
• Time that the difficulty started
• Log files at that time
• Details of any environment changes prior to the start of the issue
• Summary of the issue, including any relevant log files during the time the issue occurred

The OSIsoft Virtual Campus (vCampus) website (https://vcampus.osisoft.com) has
subscription-based resources to help you with the programming and integration of OSIsoft
products.
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